QuickStart:
Producing Your
First Music
Video Segment

Welcome to the wonderful world of music video pro-
duction! We’ll waste no time getting you started. The
CD-ROM in the back of this book contains all the clips you
need for the tutorial in this chapter. For optimal results, copy
the Nickeltown Tour folder from the enclosed CD-ROM onto
your hard drive. If you have two separate drives, copy the
folder to an empty drive or a different drive from the one
storing the Premiere program. If you need help installing the
CD-ROM contents, see Appendix A. Now fire up your com-
puter, load the trial version of Adobe Premiere, and follow
these steps!

We advise that you follow this chapter step by step from
beginning to end. By doing so, you’ll gain enough of a basic
working knowledge of Premiere that will enable you to refer to
the other chapters out of sequence if you wish to do so. Thus,
Make Your Own Music Videos with Adobe Premiere can serve
you as both a basic primer and an everyday reference manual.

Starting a New Premiere Project

Premiere refers to each video program you create as a project.
You must create a project before you can import and edit
footage. Follow these steps to start a new project:

1. Start the Adobe Premiere program. The first time you
start Premiere, the Select Initial Workspace dialog box
appears. Select A/B Editing. To find out about other
workspaces you can use, see Chapter 8.
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2. The Load Project Settings dialog box appears on your screen. Click to
expand the DV-NTSC folder, and select the Standard 48 kHz preset, as shown
in Figure 1-1.

3. Click OK. A new Premiere project opens on your screen, consisting of three
windows and three floating palettes, as shown in Figure 1-2. Premiere refers to
each of the videos you produce as a project.
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Figure 1-1: The Load Project Settings dialog box

Because you selected the A/B Editing workspace in Step 1, the following elements
appear on your screen:

4 Project window

4 Monitor window

4 Timeline window

4+ Effects Controls palette

4 Navigator palette

4+ Transitions palette
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Each of these windows can be resized or moved about the screen. To resize a win-
dow or palette, click the bottom-right corner and drag diagonally, either outward to
enlarge it or inward to reduce it. To move a window or palette, click its title bar and
then drag it with your mouse to its new location in the Premiere application window.
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Figure 1-2: Each Premiere project displays a Project window, a Monitor window, a
Timeline window, and several floating palettes.

Loading Clips Into Your Project’s Bin

Premiere defines the audio, video, and still image footage that make up your project
as clips. The Project window contains one folder, or bin, in which to store these
clips. When you produce your own video, you will need to capture (that is, transfer
from video source to computer) your video clips. Chapter 7 describes the capture
process in detail. However, for this tutorial, you need only the clips provided on the
CD-ROM.
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To import the clips to your project’s bin, follow these steps:

1. Choose File~>Import->Folder.

2. Select the Nickeltown Tour folder, which you should have copied from the
CD-ROM to your hard drive and click OK.

3. The Nickeltown Tour folder, or bin, appears in the Project window (see
Figure 1-3).

4. Save the Project now, by choosing Filer>Save. A Save File dialog box appears.

5. Type Nickeltown Tour in the File Name text box and click Save.

Your project’s name now appears in the Project window’s title bar. You can open
and close any window in your Project, except the Project window, without losing
any information. Be sure to save your work before closing the Project window. If
you don’t, you'll lose any work you’ve done since the last time you saved your
project.

Tip Unsaved information can tax the computer’s processor and causes jittery playback.
_»_ If you experience jitter as the clip plays, optimize the data by saving the project.
4 This bit of housekeeping usually makes ornery clips play back smoothly.

Opening Clips in the Project Window

You can preview clips before adding them to your Premiere project. Premiere lets
you do this easily by opening the clips directly from within the Project window.

Follow these steps to open clips in the Project window:

1. Double-click the Nickeltown Tour bin in the Project window. The bin opens
to reveal the ten files inside, including eight movie files (.av i), one audio file
(.wav), and one title file (.pt1). If you want, you can click and drag the lower-
right corner of the Project window to expand it. Figure 1-3 shows the different
parts of the Project window
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Figure 1-3: The Project window

2. Click the Project Window Menu button and then select Thumbnail view. In

this mode, a thumbnail icon represents each item.
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3. Look at the Name column. Each item has a name and is identified as either a
movie or an audio clip.

4. Now look at each thumbnail. Three of the items have a blue audio wave
along the bottom, indicating that the clip includes audio.

5. Double-click the thumbnail of the file titled maura's guitar intro.avi.
The clip opens in its own Clip window.

6. Press the L key on your keyboard to play the clip.

7. Close the Clip window when you’ve finished.

You can open each clip in the bin following these same instructions.

Creating a storyboard

A storyboard isn’t actually part of your music video, but we’ve found it to be a great
tool for outlining your video, based on the clips you have on hand. Professional
cinematographers and videographers use hand-drawn storyboards all the time.
Premiere offers storyboards that use stills from your clips as visual aids. What’s
more, you can add text to each image to further describe what your final video

will look like.

Loading clips into a storyboard
Follow these steps to place clips into a storyboard:
1. Choose File>Newr>Storyboard.

2. Drag the Nickeltown Tour bin from the Project window into the Storyboard
window. Figure 1-4 shows what the Storyboard should look like.

Each clip in the storyboard contains a still, or poster frame, from the clip, the name
and duration of the clip, and an area where you can type in descriptive information.
The Storyboard window can be resized by dragging the bottom-right corner of the
window in or out.
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Adding text to storyboard

When creating a storyboard, we usually type in the song lyrics below each clip. If a
clip is more suited for an instrumental section of the song, we type a note suggest-
ing that as well. You can add any kind of text to your storyboard that will help you

organize your clips.

1. Double-click the rectangular area below the clip named Nickeltown
title.ptl. The Edit Note dialog box appears.

2. Position your cursor inside the Edit Note dialog box and type Nickeltown
Title. You can type any kind of description in this area.

3. Click OK.

9
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Determining contents of clips

Each clip in your Storyboard window contains an image in the bottom-right corner
indicating whether the clip contains video, audio, or both. A small filmstrip icon
indicates video material, as in the E1vis chapel.avi clip. A speaker icon indi-
cates audio material, as in the Nickeltown song.wav clip. When a clip contains
both video and audio material, both icons are present, as is the case with the
maura's guitar intro.avi clip.

Arranging clip order

Rearrange the clips within the Storyboard by dragging and dropping them. Don’t
worry about overwriting Clip 1. The clips know to move forward a space. By using
Storyboards before actually arranging your clips to make your video, you visualize
what you have in the can already, and you can determine if you need more footage
to complete the story. Now, drag the clips around within the Storyboard so that
they’re in the order shown in Figure 1-5.
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Figure 1-5: Arrange clips in the Storyboard
window as seen here. Note the descriptive
text that was added.

Printing, naming, and saving your storyboard

You can print your Storyboard the way you would print any document by choosing
Filec>Print. To save your Storyboard, choose Filer>Save and specify the filename
and location.
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Arranging Your Clips in the Timeline

You sequence your clips in the Timeline to assemble your music video. You can
move a clip into the Timeline by dragging it from the Project window or from the
Storyboard window.

Placing the audio clip on the Audio track

Locate the Nickeltown song.wav file in either the Project window or the
Storyboard window, and drag it to the Audio 1 track on the Timeline, as shown in
Figure 1-6. Make sure that the clip snaps to the beginning of the Timeline by drag-
ging it flush left.

You will build your video clips to this audio track, so you don’t want to accidentally
change or move it. To prevent inadvertent changes to the Audio 1 track, click the
Lock/Unlock Track button of the Audio 1 track, just to the right of the speaker icon
at the left edge of the track in the Timeline. You should see a padlock icon when
this option is turned on.
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Figure 1-6: Drag the audio clip from the bin to the Audio 1 track on the Timeline.
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Understanding the Timeline

The Timeline shows the audio track you just dragged and dropped as a blue
rectangle. The name of the clip appears in the rectangle. Figure 1-7 shows all the
significant parts of the Timeline. When you drop the clip onto the Timeline, a yellow
bar appears along the top of the Timeline. It’s exactly as long as the audio clip, and
it has a little arrow at each end. This is called the Work Area bar, and it delineates
the borders of the beginning and the ending of the video. The bar automatically
extends as you add more clips.

Just below the Work Area bar is the Time Ruler, which measures time along the
Timeline like a ruler. If you look toward the bottom-left corner of the Timeline, you
should see the Time Zoom level. You can zoom in to see a clip frame by frame or
zoom out to see an entire song on the Timeline. For now, click the Time Zoom Level
menu and select 2 Seconds from the resulting pop-up menu.

The Edit Line marker is the pointer that sits on the Time Ruler. By moving the Edit
Line marker along the Timeline, you can easily navigate around your video. Find the
Edit Line marker and drag it forward along the Timeline to see and hear the video
and audio material in the Timeline. Dragging in this manner, as opposed to playing
the Timeline smoothly in real time, is called scrubbing. To play the video in real
time, press the spacebar. The spacebar works as an on/off switch for playing the
sequence of clips in the Timeline.
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Figure 1-7: The Timeline window
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Placing the first video clip on the Video track

Now that you’ve given the music video a song, you can add visual content, such as
video clips and still images, from your bin or Storyboard window. To place a video
clip in the Timeline, follow these steps:

S

1. Locate maura's guitar intro.avi in the Storyboard window and drag it

to the Video 1A track. (Place the clip at the very beginning of the Timeline.)

After you've dropped the video clip onto its track, another clip of the same title and
duration appears in the Audio 2 track. This happens because this clip contains
both audio and video material. In this case, the audio and video material is sepa-
rated in the Timeline. The video information is placed on a Video track, and the
audio information is placed on an Audio track. If you click and drag either clip up
and down the Timeline, the corresponding clip is dragged with it. The tracks are
linked in this way. If you delete the audio clip from the Timeline, you also delete its
corresponding video clip. When you delete a clip from the Timeline, you do not
delete the actual clip; you delete the placement of the clip in the Timeline.

2. Drag the Edit Line marker to the beginning of the Timeline.

. Press the spacebar to play the video. The video plays in the Monitor window,

and you’ll hear both audio clips play at the same time. The audio portion of
the video plays later than the music on the Audio 1 track. In other words, the
clips are out of synch, and you have to put them in synch with each other
(covered in the following section).

Synching video to audio

Use the audio portion of the maura's guitar intro.avi clip as a tool to line up
or synch, the video to the Nickeltown song.wav audio clip. There’s no real scien-
tific way to do this; you just have to use your ears and your eyes.

Follow these steps to synchronize video to the audio clip:

1. Delete all clips from the Timeline except Nickeltown song.wav.
2. Drag the Edit Line marker to the beginning of the Timeline.

3. Press the spacebar to start playback of the Timeline. Notice that the music

volume doesn’t fade in; the guitar strums right away at normal volume.

4. Press the spacebar again to stop.

5. Double-click maura's guitar intro.avi in the Project window. A Clip

window opens, which displays the first frame of that clip. See Figure 1-8 to
identify the elements of the Clip window.

. Play the Clip window’s clip by either pressing the spacebar or by clicking

the Clip window’s Play button.

13
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Figure 1-8: The Clip window

Editing the in point

Most of the time, your clips will contain superfluous material, that is, more footage
than you want to use in your Premiere project. You can edit the clips to create new
starting points, or in points. In the audio portion of the maura's guitar intro.avi
clip, you can hear a little pause before Maura starts strumming the guitar, so you'll
need to edit that part out. The desired effect is to have the guitar strum in the video
track at the same time it’s strummed in the audio track.

Follow these steps to edit the beginning of the clip:
1. In the Clip window, drag the Edit Line marker to where you first hear the
guitar strum (00;36;54;00).

2. Mark this as an in point by either choosing Mark=’In from the Marker Menu
or by pressing the I key.

3. Click the Play In To Out button to play the clip starting at the new in point.
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4. Drag the clip from the Clip window to the Video 1A track in the Timeline,
flush left. You may need to resize the Clip window to see the target video
track. Premiere automatically places the audio portion of maura's guitar
intro.avi on the Audio 2 track.

5. Close the Clip window.

6. Drag the Edit Line Marker to the beginning of the Timeline and press the
spacebar to play the video.

What you hear is a combination of the Nickeltown song.wav audio clip and the
audio portion of maura's guitar intro.avi. The clips are much more in synch
now than they were before you edited the in point. When the Edit Line marker
moves beyond the range of the first video clip, you’ll hear the volume drop as the
audio clip on the Audio 2 track drops out.

Because the audio is close and only needs slight adjusting, at this point, editing
without hearing the Audio 2 track is easier. You started out putting these two tracks
together by using your ears to locate the beginning of the song. Now you’ll use your
eyes to match up the visual of the guitar strumming to the sound of the guitar on the
Audio 1 track. Remember, the sound on the Audio 1 track is the only sound that will be
in the final video. You should use the music on the Audio 2 track only as a guide.

Deleting unwanted audio

If you try to erase an audio track that is linked to a video track, both tracks will be
erased, unless you first take the video and audio out of synch by pressing the
Toggle Synch Mode button at the bottom of the Timeline window to take the Audio
and Video tracks out of synch.

Follow these steps to delete unwanted audio from a video clip:

1. Click the Toggle Synch Mode button to take the video and audio tracks out
of synch. See Figure 1-9.

2. Select Maura’s guitar intro clip on the Audio 2 track.

3. Press the Delete or Backspace key on your keyboard. The corresponding
clip on the Video 1 track was not deleted because the video and audio tracks
are no longer linked.

4. Check to see how the video and audio is synched at this point by pressing
the Play In To Out button on the Monitor window. The video is now in synch
with the audio!

15
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Figure 1-9: Take the video and audio tracks out of synch by clicking
the Toggle Synch Mode button on the bottom of the Timeline.

5. Now drag the Edit Line marker to the beginning of the Timeline.
6. Click Play.

Editing the out point

Just as you can edit the in point of your clips, you can also edit the clips to create
new endings, or out points. Because the acoustic guitar strums to the beat of the
song, it will help you to think of this song in “beats.” Because the acoustic guitar
plays each beat with a downstroke on the guitar, you can use that as a guide to the
beats. A downstroke is each time the hand strums the guitar from the top down-
ward. You will see an upstroke in between each downstroke. The very first sound on
this audio track is a downstroke. It’s your job to match the downstrokes of the
video with the downstrokes of the audio.

We used the first nine downstrokes of this clip as our first clip of the video. This
clip contains eleven downstrokes, so you need to edit out the last two downstrokes
by changing the out point. Here’s how:

1. Double-click the maura's guitar intro.avi clip on the Video 1A track.
The Clip window opens.

2. Click the Play In To Out button.

3. Count the downstrokes as the video clip plays.

4. When you count the ninth downstroke, press the spacebar to stop playing
the clip. The actual frame that we stopped on is 00;36;58;05.

5. To mark the same out point that we used, drag the Edit Line marker to
00;36;58;05.

6. Press the O key to set this out point. After you set the out point, the Apply
button appears below the transports.

7. Click the Apply button to apply the changes to the clip in the Timeline. If
you close the Clip window without applying the out point, you will lose your
out point and have to reset it.
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8. Close the Clip window.
9. Click the Play In To Out button on the Monitor window.

You have successfully synched your first clip to the audio track and edited the
clip’s duration.

Look for the light

It has been said that good lighting makes the difference between a good
video and a bad one. If that's true, then we should have given up at the
start, because we didn't have any lights, good or bad. But ignorance and
s lack of funds worked in our favor. Because we couldn't set up elaborate
e gear, we just traveled to places that had interesting existing light and shot
- O there! Our early experience taught us to always look for the available light
Road Diary fist and then add to it if we needed to. If the existing light was sufficient,
we stuck with it, and we still do.

Our friend Kate Wolf wrote a song about an elderly man who lived on a farm in Oklahoma.
She was visiting him, and when she was leaving the house one day, he pulled her aside. His
hearing was weak, so he spoke in a loud voice. “Look for the light,” he said. “You gotta look
for the light!” He wasn't speaking figuratively. He really meant it. And it was good advice.
Everything that we see, we see because light is falling on it. Thomas Edison opened up the
nighttime to new possibilities by making light readily available at all hours, and film made
illuminated images portable. When we shoot video, it is the light falling on objects that we
are shooting. So light is the essence of visual art. Get in the habit of looking for it. When you
walk into a room or into a natural environment, keep in mind that you can see things
because light is coming from somewhere. Where's it coming from? What is the source?
What direction is it coming from? Is it shining directly or reflecting off of something? Where
does it make shadows fall? When you look at a face, is it completely or partially lit? What
mood does the light create?

Master painters have spent centuries studying light, and present-day cinematographers
study painters to see how light can bring objects to life. During the Renaissance, painters
began portraying real people in real situations, and they drew their subjects lit by light from
a believable source. Rembrandt, for example, did a number of self-portraits, and he lit his
own face from above and to the right. Doing this created a realistic character, with shadows
falling across parts of his face. We can see that he is “one of us,” but we don’t know every-
thing about him. He has emotions, he has a complex personality, and his face conceals as
much as it reveals. The 17th century Dutch painter Jan Vermeer painted many of his sub-
jects in their homes, and he used the natural light coming in through windows to illuminate
them. Study how he uses shadows, stained glass, and reflections to bring his characters to
life. When you look at a painting, look for the light, just as you would in a “real” situation.
Then, when you look through your viewfinder, especially if you use an LCD screen, think of
the shot as a painting and consider how the light is helping you tell the story. What does it
reveal about your subject and what does shadow conceal?

Continued
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Continued

In the film The Godfather, cinematographer Gordon Willis used two basic lighting schemes.
When the gangsters were with their families, the shots were brightly lit with sunlight and
overexposed to look like 1950s era family photos. When the heavies went behind closed
doors, they were in shadow, with yellow filtered light creeping in. The lighting reinforced
the basic images of good and evil. The gangsters’ faces, in these darkened scenes, were lit
from directly above. This angle is not normally used because it puts the subjects eyes in
shadow. This creates a feeling of unease in the viewer. When we communicate with some-
one, we take signals from their eyes. But in this film, we can't tell what Marlon Brando is
thinking, because we can see the set of his jaw, but we can’t read his eyes. The shadowvs tell
us that he's in control, and he's probably up to no good. Consider how you would light the
face of Katrina and the Waves singing, “Walking on Sunshine” versus “White Wedding” by
Billy Idol. How would you use light and shadow to make the singer in your band look
friendly or mysterious to reinforce a lyric?

Placing the vegas club sign.avi clip on the Video track

Drag the vegas club sign.avi clip from the bin or storyboard onto the Video 1A
track, flush left to the first clip. You've just created the simplest type of transition —
the cut. There is no fade-in or fade-out in a cut. One clip ends and the next begins
right away. Play the video through the first two clips.

Changing the speed of a video clip

We love timing visuals with rhythmic beats in our videos. You may decide that this
is your style too, but it’s not a rule, by any means. The three lights that comprise
the sign in this clip turn on in sequence. In the clip’s unedited state, the sign lights
up at a quicker tempo than the beat of the song. Your goal here is to match each
light to consecutive downbeats. Premiere offers the option of adjusting the speed
of a video clip.

To synch the speed of the light sequence to the tempo of the downbeat, follow
these steps:

1. Select the vegas club sign.avi clip in the Timeline.
2. Choose Clip~>Speed.
3. Type in 70.

Alote A number lower than 100 slows down the clip, adding length to the duration. A
=~ number higher than 100 speeds up the clip, shortening its duration.

4. Click OK.
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A red bar appears directly under the Work Area bar, along the length of the clip
whose speed you just adjusted. The appearance of this red bar means that you
made an adjustment that has yet to be processed or rendered. The next section
shows you how to render your edits.

Building a preview

Premiere builds previews for all the clips to which you apply effects. Before you can
view the effected clips fully processed, you need to render the effects by building pre-
views. To build a preview of all the material in the Timeline, press the Enter (Return)
key on your keyboard. After you do that, a Building Preview status bar appears, indi-
cating how many frames and how much time the Preview will take to build. The video
then plays automatically from the beginning when the preview is complete. A green
bar replaces the red bar when Premiere finishes building the preview.

Editing the in point of the clip

The tempo of the lights now matches the tempo of the music, but they come in
behind the beat, or after the downbeat. You need to line up the visual “beat” of the
first light coming on to the musical downbeat.

To remove some frames from the beginning of the clip, follow these steps:
1. Double-click the vegas club sign.avi clip on the Video 1A track. The
Clip window opens.
. Use the right-arrow key to move to frame 00;10;53;27.
. Press the I key to set the in point.
. Click the Apply button below the transport buttons in the Clip window.

. Close the Clip window.

[=235) S SR U

. Drag the vegas club sign.avi clip flush right to the maura's guitar
intro.avi clip in the Timeline.

7. Press Enter (Return) to build the preview.

Editing the end of the clip

The vegas club sign.avi clip is still running when the vocal line comes in. The
objective here is to stop the vegas club sign.avi clip from displaying just before
the vocals start.

To edit the out point of the clip, do this:

1. Drag the Timeline’s Edit Line marker to where the vocal comes in (around
00;00;08;06). Use the arrow keys on your keyboard for precision placement.
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g

2. Position the cursor over the right edge of the clip in the Timeline window
so that the Selection tool turns into a Trim tool.

3. Drag the end of the clip to the left, stopping at the edit line.
4. Release the mouse button.

5. Build the preview by pressing the Enter (Return) key.

Cropping a clip

The vegas club sign.avi clip was filmed in “old movie mode” on our camcorder.
Aside from adding a cool sepia effect to this clip, it also gives the clip the illusion of
being wide-screen, by adding areas of black on the top and bottom of the moving
image. If your entire video is shot in this mode, you could just leave it alone for a
continuous old-time effect, but because it’s the only clip in this video that was shot
in old movie mode, you’ll have to crop the clip with a video effect to make it uniform
with the surrounding clips.

To crop the clip, perform the following steps:

1. Choose Window=>Show Video Effects.

2. Click the Find Video Effect button, represented as a binoculars icon, at the
bottom of the Video Effects palette, as shown in Figure 1-10. Premiere pro-
vides nearly 100 different video effects in the Effects palette. You can either
look through them all by hand — which we recommend you do at some point
to familiarize yourself with the available effects — or you can search for the
effect you want using this find feature.

Figure 1-10: The Video Effects palette find tool enables
you to quickly search Premiere’s video effects.
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3. Type the word crop in the Find Video Effect text box that appears on your
screen.
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4. Click the Expand Folders box, so that a check mark appears.
5. Click Find.

6. The folder containing the Crop effect (the Transform folder) expands, and
the searched effect is selected. Click Done.

7. Drag the Crop effect from the Video Effects palette to the vegas club

sign.avi clip. A green bar appears at the top edge of the clip in the Timeline,

indicating that an effect has been applied. The Effect Controls palette opens
on your desktop, and the Crop effect controls are displayed.

8. Resize the Effect Controls palette by dragging the lower-right corner of the

palette to reveal all the controls for this effect.

9. Crop the top of the clip by dragging the Crop Top slider in the Effect
Controls palette from 0 to 10 and crop the bottom of the clip by dragging
the Crop Bottom slider from 0 to 10, as shown in Figure 1-11.

10. Render the work area by pressing Enter (Return).

A Monitor

o485
MRS

Figure 1-11: The Effect Controls palette displays different
controls for each applied effect.

Synching the Pete & Maura sing clip to the audio

Drag the Pete & Maura sing.avi clip from the bin or Storyboard to track Video
1A in the Timeline, flush left with the last clip. You need to synch this clip with the
music. It has audio material that will help you do this. Synching is most important
in the placement of this clip, because the subjects are actually singing, and you
want to make it look realistic. Make sure that the Toggle Synch Mode button is
switched on.

Setting the in point
Here, you should use the same techniques you used earlier when synching up the
guitar intro in the section “Synching video to audio.”
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1. The vocal starts right up at the end of the preceding clip, so the best way to
synch this clip to the audio is to first toggle the Audio 1 track output to shy
state, which mutes the track’s audio. Click the speaker icon at the left edge of
Audio 1 track, so the icon disappears to make the audio track shy, as illus-
trated in Figure 1-12.

& Timeline

0;00:08:00 0;00; 1600 0;00;24;00

Toggle Track Output/Shy State

Figure 1-12: The Toggle Track Output/Shy State button turns a
track on or off, without deleting the track from the Timeline.

2. Drag the Edit Line marker just to the left of the Pete & Maura sing.avi
clip and then press the spacebar to play.

3. When you hear the vocal entrance, press the spacebar to stop.

4. Position the cursor over the left edge of the clip until it turns into the Trim
tool.

5. Drag the in point to the Edit Line. Slide the clip flush left with the previ-
ously placed clip.

6. Toggle the Audio 1 track back out of its shy state.
7. Make the Audio 2 track shy.

8. Make the necessary placement adjustments to make the video and audio
synch up perfectly. (You may need to resize the Monitor window to see if the
lip-synching works. If so, drag the lower-right corner of the Monitor window
downward.)

If the video seems to be ahead of the audio or rushing, you need to add frames to
the beginning of the clip. Slide the clip to the right by clicking the clip and dragging
it to the right in the Timeline, and use the Trim tool to click and drag the in point to
the left. If the video seems to lag behind the beat of the audio, you need to remove
frames by dragging the in point to the right and sliding the video flush left to the
preceding clip.
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Setting the out point

Although the Pete & Maura sing.avi clip contains an entire verse, you’'ll only
use the first line of the song: “She had her eye on Egyptian gold.” You need to set
the out point to truncate the clip.

1. Drag the out point of the Pete & Maura sing.avi clip to the left to include
only the portion of the clip that ends with the word gold.

2. When the clip is in synch, take the video and audio tracks out of synch by
clicking the Toggle Synch Mode button.

3. Delete the corresponding audio clip from Audio 2 track. (See the section
“Deleting unwanted audio” earlier in this chapter.)

Placing the Maura in green.avi video clip
into the Timeline

The next clip further establishes the wackiness of Las Vegas by showing Maura in a
head-to-toe, lime-green polyester bellbottom pantsuit! To add this clip to the
Timeline, follow these steps:

1. Double-click the Maura in green.avi clip to open it in a Clip window.

2. Drag the Clip window’s Set Location Marker left or right so that the Current
Clip Location reads 00;46;47;07.

3. Press the I key to set the in point.

4. Drag the Set Location Marker to where the Current Clip Location reads
00;46;50;25.

5. Press the O key to set the out point.
6. Drag the clip from the Clip window to the Video 1 track of the Timeline,
flush left with the last clip on that track.

You should save your work periodically as you edit your video to avoid the risk of
~, accidentally losing work if either Premiere or your whole system crashes.

@

Cross-dissolving into the next clip

The next transition is not a cut, like the transitions so far. The clip you just placed
in the Timeline cross-dissolves into the next clip. To apply a Transition, you must
first have two video clips that overlap on two different video tracks on the
Timeline. You then apply a Transition onto the Transition track.
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Positioning clips
Follow these steps:
1. Double-click the Maura at chapel.avi clip to open the Clip window.
2. Edit the clip’s in point to be 00;53;53;01.
3. Edit the out point to be 00;53;55;22.
4

. Drag the clip over the Timeline’s Video 1B track so that it slightly overlaps
with the previous clip on the Video 1A track. You want the clips to overlap
because in a cross dissolve, which is the transition you will apply, you blend
one clip with the next.

5. Click and drag the Edit Line Marker to be placed over the overlapping
clips.

6. Select 1 Frame in the Time Zoom Level.

7. Click and drag the Maura at chapel.avi clip to overlap by between
15 and 20 frames.

Applying the transition
After overlapping the video clips, you're ready to choose a transition from the float-
ing Transitions palette.

To select and apply a transition to a clip, follow these steps:

1. Click the Transitions tab on the Video Effects palette, as shown in Figure
1-13. If the Palette is not visible, choose Window=>Show Video Effects.

2. Click the Search icon (binoculars) at the bottom of the palette.

Figure 1-13: The Transitions share a palette with the Video
Effects.
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3. Type Cross Dissolve.
4. Click Find.

5. When the Cross Dissolve transition is located, click Done.
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6. Drag the Cross Dissolve transition to the Transition track between Video 1A
and Video 1B tracks. Position it exactly where the two clips overlap. It should
be flush left with the beginning of the clip in the Video 1B track and flush right
with the end of the clip in the Video 1A track. Premiere automatically sizes the
Transition to fit the overlapping clips. (See Figure 1-14.)

7. Build the preview by pressing Enter (Return).
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Figure 1-14: Drag transitions to the Transition track, between two overlapping
Video 1A and Video 1B clips.

If you don’t render the work area, the monitor screen goes black, and a small white
Xx appears, indicating an effect that needs to be rendered.

Why some transitions are straight cuts and others are dissolves is a matter of per-
sonal style. In this video sequence, we used cuts at the beginning of the video to
establish the style and location of the song. Almost immediately, the lyrics flash
back to “. .. when she turned 18 years old, with just a dream and a Vegas vow. . ..”
That flashback, along with the dream-like lyrics suggested a dreamier transition,
and Cross Dissolve was our transition of choice.

Raiding the rag and bone shop

We never pass a vintage clothing store without grabbing the camera. To
some, it might be a junkshop, but to us, it's a storehouse of potential free
props. Ask for permission to shoot some video. The person at the register is
usually the owner. They don’t make enough money to hire staff. We've been
A= turned down, usually in places where they figure they can make money
renting out the stuff for movies. That's okay; they're eking out a living in the
Road Diary jjternative world, so more power to them. Most times, though, they get
behind the idea. We usually start by interviewing the owner. Most of them
are people who have traveled a lot. You cover a lot of miles in the search for vintage kitsch.
Some of them are people who lived for years in the straight world and then chucked it all for
a life selling polyester shirts to fledgling rock bands. Like I said, more power to them. They let
us spend the day shooting in their store, and we give them a plug on stage at our next gig.

Continued
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Continued

Anyway, with the interview in the can, we start looking through the racks for cool stuff.
Polyester shirts from the 1970s are great on-screen, providing instant color. Groovy wigs
abound, and other props are often scattered around. Basically, we co-opt the ambience of
the place, which usually could be summed up in one word: Groovy.

We were shooting our video for “Free” on the streets of Athens, Georgia, when we came
across a great thrift shop. The owner was glad to give us the run of the place, and we scored
a lot of shots there. She had a super-cool 1960s-era eight-track player, with a built-in mirror
ball! We found that, by shooting close-ups of the mirror ball, we could get great retro look-
ing lighting effects, with the colors changing randomly as the orb moved around. Some of
the cheesier shots were reminiscent of Peter Fonda’s seminal film The Trip, one of the first
hippie movies. Fonda’s film would meander away from reality into lens-filling kaleidoscopic
effects, a technique we frequently find useful, especially when we don’t have any good clips
left in the bin. There was also a great old velvet couch, and Maura started grabbing vintage
clothes. I recall a lot of leopard skin. We started lip-synching “Free.” | remember wearing a
huge cowboy hat at one point. Budget for costumes and effects on this shoot — zero. Thank
heaven for the quirky nationwide network of thrift shop gypsies. By the way, avoid any
place with the word Antique out front. They'll call the police if you even look like a musi-
cian, a guerilla filmmaker, or anything other than a rich potential customer. Look for the
words “thrift,” “vintage,” or “junk,” and avoid the A-word.

Placing the remaining clips in the Timeline

The remaining clips will round out the video segment by introducing the Las Vegas
wedding scenario into the story. To add remaining clips to the Timeline, follow
these steps:

1. Drag the Vegas wedding.avi clip to the Timeline’s Video 1A track and
overlap it with the Maura at chapel.avi clip by about the same margin.

2. Apply the Cross Dissolve transition between the Vegas wedding clip on
track Video 1A and the Maura at chapel.avi clip on track Video 1B. (See
the section “Cross-dissolving into the next clip.”) Figure 1-15 shows a detail of
this cross dissolve transition.

3. Build the preview. (See the section “Building a preview,” earlier in this
chapter.)

4. Drag the E1vis chapel.avi clip to the Video 1A track, flush left with the
last clip. This is another cut, as opposed to a cross-fade transition.

5. Drag the Maura and Elvis.avi clip from the bin or Storyboard window to
the Video 1A track, flush left with the E1vis chapel.avi clip. This is
another cut.

6. The end of this clip jumps to a useless shot of the back of our van. Edit the
out point so that the clip ends just before this, when Elvis gives the thumbs up.
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Figure 1-15: Detail of Cross Dissolve transition between two clips

Adding Video Effects

The video tour is now in sequence, with the proper cuts and transitions all in place.
You can give this sequence more life with a few simple video effects.

Adjusting brightness and contrast
The Pete & Maura sing.avi clip is nice, but it’s quite dark. We can, however, use
one of Premiere’s Video Effects to brighten it up. Here’s how:

1. Click the Video tab on the Video Effects palette.

2. Expand the Adjust folder, by clicking the right-pointing arrow to the left of
the Adjust folder in the Video Effects palette.

3. Select the Brightness and Contrast effect and drag it to the Pete & Maura
sing.avi clip on track Video 1A in the Timeline.

4. The Effect Controls palette opens to reveal the available controls for this
effect.

. Set the Brightness by dragging the triangle-shaped slider to 60.
. Set the Contrast, this time by clicking the underlined Contrast value number.

. Type in 60.3.

@ N & O

. Click OK. You can set Brightness and Contrast by using either of the two
above procedures.

Changing the color balance

Because the first lyric sets the stage with, “She had her eye on Egyptian gold,” we
wanted to reflect the magic of the dream of Las Vegas riches, by having the clip’s
overall hue turn to gold. You can do this by adjusting the color balance and then
applying a keyframe. A keyframe changes an effect over time. You may define as
many keyframes as you want in each clip. Premiere automatically sets two
keyframes — one at the beginning and one at the end of each clip. By defining an
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effect’s values at the beginning of the clip and changing the values at a later point in
the clip, you give the effect motion.

Follow these steps to adjust color balance:

1.

Locate the Color Balance video effect in the Adjust folder of the Video
Effects palette.

. Drag the Color Balance effect over the Pete & Maura sing.avi clip in the

Timeline.

. The Effect Controls palette now adds the Color Balance effect, below the

Brightness and Contrast effect you applied in the last exercise. The Effect
Controls palette reflects the effects of whichever clip is currently selected.

. Click the Enable Keyframing box of the Color Balance settings in the Effect

Controls palette, as shown in Figure 1-16.

Enable Keyframing

B Figure 1-16: The Enable Keyframing box enables you

Effect Jontrols 4 [nfa . . .
to change video effects on a clip over time.
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. Expand the Video 1A track by clicking the arrow on the left side of the

Video 1A track.

. Drag the Edit Line marker to where you hear the word “gold.” We want the

gold video effect to be fully in place by this point in the clip.

. Adjust the Color Balance controls in the Effect Controls palette as such:

Red = 100, Green = 178, and Blue = 0. You may need to scroll down to dis-
play settings. These settings result in an overall yellow hue.

. Click the Next Frame arrow on the left edge of the Timeline, as shown in

Figure 1-17. The Edit Line marker then moves to the next keyframe.

. Set this keyframe’s parameters to the same values you set in Step 7 to apply

the gold effect throughout the rest of the clip.
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10. Build your preview. (See the section “Building a preview” earlier in this

chapter.)
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Figure 1-17: Advance to the next keyframe by clicking the Next
Frame arrow in the expanded video track.

Hyping colors with Brightness and Contrast

Hyped color, also known as color saturation, is very important in music videos. You
have three and a half minutes to capture your viewer’s attention, and hyping the
colors is a proven way to do just that. After you set the parameters of an effect that
you are going to use over and over, you don’t need to redefine the settings each
time. We used the same Brightness and Contrast settings in several of our clips.

1. Drag the Brightness and Contrast effect to the Maura in green.avi clip on

the Timeline.
2. Set the Brightness for 19.7.
3. Set the Contrast for 45.9.

4. Build your preview. Notice that the greens are much more vivid, reflecting

the flashiness of Las Vegas.

@ N & O
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. While the Maura in green.avi clip is still selected, choose Edit=>Copy.
. Select the Maura at chapel.avi clip.
. Choose Edit~>Paste Attributes.

. Select Settings and check only the Filters box, as shown in Figure 1-18.

Figure 1-18: The Paste Attributes feature enables
you to apply settings you frequently use, without
having to go through all the setup steps each time.
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9. Click Paste.
10. Select the Vegas wedding.avi clip.
11. Choose Edit~>Paste Attributes Again.
12. Press Enter (Return) to render the work area.
13. The Vegas wedding.avi clip still seems a little dark. Select that clip.

14. In the Effect Controls window, set the Brightness value to 45.9 and the
Contrast value to 65.6.

Blurring a clip

We wanted to give a slight blur to the Maura at chapel.avi clip, suggesting the
dream that’s reflected in the lyrics.

Here’s how you blur the clip:

1. Open the Blur folder in the Video Effects palette.

2. Select Antialias and drag it to the Maura at chapel.avi clip. Antialias is
one of the few Premiere video effects that is either on or off — it offers no
other settings to configure.

The best Elvis on the Vegas strip

By the way, you're probably wondering who portrays the groovy Elvis in our
Vegas clips. It's Brendan Paul, the top Elvis interpreter on the scene today. If
you've ever seen the 1968 Singer TV special, you know the intense
dynamism that Elvis generated when he was at his best, and Brendan
S = embodies that excitement and charisma. He's usually jetting around the
& - country doing high-priced gigs, so weddings aren’t normally his thing, but
Road Diary e jucked out. He happened to be in town and he had an hour free the
afternoon we renewed our vows, so we were able to snag him. He not only
gives the coolest reading of the wedding vows, but he sings several songs as well, including,
“It's Now or Never.” Because we knew the Jordannaires’ parts we joined right in on the back-
ground vocals. It was a day we'll always remember, and the video footage is one of the gems
of our collection. In fact, we were in Los Angeles a few weeks after the ceremony, and our
van disappeared, towed away by the LAPD. Our first reaction was, “Oh, my gosh! The Elvis
video!” We didn't care about the van, but we didn’t want to lose the video, especially the
footage where Maura's crying. The ceremony ended with a dynamic rendition of “Viva Las
Vegas,” with all three of us singing and dancing our hearts out. Check this performance out
on the complete “Nickeltown” video on the CD-ROM. If you need an Elvis, and you can
afford the best, Brendan Paul’s your man. See Appendix D for his contact information.
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Fading Out the Audio

=]

Most music videos follow the fade on the recorded music. Because this tutorial only
uses a portion of the song, you can fade the rest of the song out.

Perform the following steps to fade out the music:

1. Unlock the Audio 1 track on the Timeline by clicking the Lock/Unlock

Track button at the left-hand edge of the Track.

. Expand the Audio 1 Track by clicking the triangle at the left of the track, as

shown in Figure 1-19.
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Figure 1-19: The Collapse/Expand Track button can expand the
track to reveal further information about your track.

. Notice the red line that runs the length of the Nickeltown song.wav audio

clip. This line is called the Volume rubberband. (If the line is blue, click the
red Display Volume Rubberbands button.) Each Volume rubberband contains
two handles, which are movable volume controls — one at the beginning of
the clip, and one at the end.

. Position the Selection tool over the Volume rubberband until the arrow

turns into a pointing finger.

. Position the pointing finger over the Volume rubberband at a point even

with the beginning of the last video clip.

. Left-click the Volume rubberband to create a volume handle, as shown in

Figure 1-20.
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Figure 1-20: Add Volume handles by clicking the Volume
rubberband.

7. Move the cursor to the handle at the very end of the Nickeltown song.wav
audio clip. Click and drag it to the bottom of the clip, as shown in Figure 1-21.
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Figure 1-21: Drag the Volume rubberband down to create an
audio fade-out.

Adding a Title

Titles contain text, which is opaque, and an Alpha Matte, which is the transparent
area around the text. The Alpha Matte enables the underlying video to show
through between and around the text. Music video titles often fade in and out. Your
last task in this tutorial is to create an MTV-style title for your music video.

Use the following steps to create an MTV-style title:

1. Position the Edit Line at 00;00;07;23 by clicking and dragging the Edit Line
marker.

2. Drag the Nickeltown title.ptl clip from the bin or Storyboard onto the
Video 2 track of the Timeline, flush left to the Edit Line.

3. Expand the Video 2 track to reveal the Opacity rubberbands. Opacity

rubberbands in the Video track are similar to the Volume rubberbands in the
Audio track. You can think of it as a volume control for the opacity of the clip.
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4. Position the Edit Line marker at the left edge of the Nickeltown title.ptl
clip.

5. Move in ten frames by pressing the right arrow key on your keyboard ten
times.

6. Hold the cursor over the red Opacity rubberband at the point where the
Edit Line is located.

7. Click the Opacity rubberband to create a new handle.

8. Hold the cursor over the first Opacity rubberband handle at the very
beginning of the clip.

9. Click the handle and drag it all the way down.
10. Move the Edit Line marker to the end of the title clip.

11. Move back ten frames by pressing the left arrow key on your keyboard ten
times.

12. Hold the cursor over the Opacity rubberband where the Edit Line lies.
13. Click the Opacity rubberband to create another handle.

14. Click the very last Opacity rubberband handle and drag it all the way
down. Your title clip should look like the one in Figure 1-22.

15. Render the work area.

& Timeline
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Figure 1-22: The Opacity rubberbands enable you to set fades
on your titles.

You may want to keep the title clip handy to modify and use in your own videos. It’s
set up like a standard MTV title. Of course, you're not limited to using this style;
you can be as creative as you like. (See Chapter 10 for more on titles.)

You've just completed the tutorial. Premiere is simple and easy to use! Of course,
we couldn’t possibly cover all of Premiere’s powerful tools in this chapter, and
that’s why you need to read the rest of this book and follow all the step-by-step
examples.
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Chapter Replay

After reading this chapter and following along with all the step-by-step instructions,
you should:
4+ Have a general understanding of how a video is assembled

4 Be familiar with some of the issues inherent to music video, including synching
video to audio, and using the beat of the song to help you align clips

4+ Understand the concepts of adding video effects and transitions
4 Understand how to add titles

Chapter 2 describes all the steps involved, the resources required, and the costs
associated with making music videos with Adobe Premiere.

+ ¢+



